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What’s New

About This Release
The release of Autodesk® Lustre® 2011 introduces many new and updated
creative tools, as well as workflow improvements. See the themes below for a
quick overview, and then follow the links for more detailed information.

Configuration Files
The following are new parameters added to the init.config file.

FunctionDefaultData
type

Parameter

<Locations>

Defines the location of
the global Grade bin.

String<GlobalGradeBinHome>

Defines the location of
the LUTs.

[LUSTRE_HOME]/lutString<LutHome>

Defines the location of
the presets.

[LUSTRE_HOME]/pre-
sets

String<PresetsHome>

Defines the location of
the plugins.

[LUSTRE_HOME]/plu-
gins

String<PluginsHome>

Defines the location of
the templates.

[LUSTRE_HOME]/tem-
plates

String<TemplatesHome>

1

1



FunctionDefaultData
type

Parameter

<MediaBrowserHideFolders>

Hides the degrain
cache, original, matte,

degrain_cache,
original, matte,

String<HideFolder>

marry grade, andmarry_grade, and
128x96 128x96 folders from

the file browser.

NOTE You can hide
any additional folder
by adding the folder
name to the list.

<Wiretap>

Applies the correct as-
pect ratio to PAL resol-

1.3333333333333Float<PALImageAsepectRatio>

ution footage
rendered to the
Wiretap server, but
not imported from the
Wiretap server.

Allows you to map
hostnames to IP ad-

0.0.0.0String<PathTranslationTable>

dresses, as well as to
define path translation
rules. See “Defining a
Path Translation
Table” in the Lustre
2011 Release Notes for
more details.

Applies the correct as-
pect ration to NTSC

1.3333333333333Float<NTSCImageAspectRatio>

resolution footage
rendered to the
Wiretap server, but
not imported from the
Wiretap server.

<AVIO>
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FunctionDefaultData
type

Parameter

Timecode delay when
you are writing to

10Integer<VtrTCTD>

telecine tape with an
HDCAM SR.

<PenTablet>

TabletDevice specifies
parameters for each

left=”7”,
right=”7”,

string
name, in-

<TabletDevice>

pointer device. Thetop=”10”, bot-
tom=”15”

teger
left, in- "name" attribute cor-
teger responds to the name
right, in- of the device as found
teger in the X.org configura-
top, in- tion file, usually “wa-
teger
bottom

com”, “eraser” or
“cursor”.
For each device, the
"left", "right", "top"
and "bottom" attrib-
utes specify the device
margins, as a percent-
age of the tablet width
or height.

NOTE This keyword is
only available for Win-

dows® workstations.

<Miscellaneous>

When this keyword is
enabled, Lustre reads

OnState<DPXHeaderOffsetCheck>

the DPX / Cineon® file
header of each frame
in a sequence. This is
useful when using DPX
/ Cineon files that
have a different media
offset within the same
sequence of files.
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FunctionDefaultData
type

Parameter

When disabled, Lustre
reads only the first
frame header of a se-
quence.

WARNING Turning
this keyword on can
alter playback perform-
ance.

Project and User Management
New options have been added to the project and user configuration settings.

User Configuration
You can delete the context file associated with a user profile by holding the
Shift key and clicking the Delete button in the User group. (You must confirm
the deletion.)

Calibration Settings
When you are working with an OpenEXR file, the file needs to be converted
from a 16-bit float to a 16-bit integer. Within the Calibration settings of the
project configurations, there is now the Float Conversion LUT panel which
allows you to convert your OpenEXR file to a 16-bit integer Lustre internal
format.

Rendering Settings
In the Marry Grade panel of the Rendering menu, the options of the Marry
Grade Format option box have been changed.

To:Select:

Save marry grade files and attribute an identifier based on the
wedge pair to each filename.

Based on Wedge
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To:Select:

Save marry grade files and attribute a unique identifier (UID) to
each filename.

Based on UID

Many enhancements affect marry grade files. See Marry Grade Support on
page 15.

Engineering Settings
The Graphic SDI Display option box has two new options.

To:Select:

Fit the image to the width of the monitor at the SDI out.Fit W

Fit the image to the height of the monitor at the SDI out.Fit H

Display & Interface Settings
When you enable the Update Storyboard button in the Display panel, your
Storyboard thumbnails will automatically be updated whenever you apply a
change to your shot.

LTC Chase Option on the AJA BOB
Previously, the LTC Chase option in the Audio menu was only available for
the DVS BOB. Now you are able to chase an external audio device if you are
using an AJA BOB. Since the AJA BOB does not have a TC plugin, you will
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need to use one of the audio lines. See Playback Using the LTC Chase Option
on page 21.

Browsing for Footage
The following are the enhancements made when you are browsing for footage
on Lustre.

Wiretap Gateway
The Wiretap Gateway server makes it possible to ingest complex media formats
with ease. The following general improvement have been made:

■ The timecode range now displays the correct information when browsing
clips through the Wiretap Gateway.

■ RDC folders containing as such. Instead, the RED® media contained within
them is displayed.

■ The current version of the Wiretap Gateway is now visible within the file
browser.

OpenEXR Media
OpenEXR media can now be imported using the Wiretap Gateway. Lustre
supports the following OpenEXR formats:

■ OpenEXR, 16-bit float (.exr), including compressed OpenEXR files (ZIP,
RLE, PIZ, PXR24, B44, and B44A).

NOTE The playback rate of compressed files varies, depending on the
compression scheme and the number of Wiretap Gateway slaves defined in
the wiretapgateway.cfg file.

■ OpenEXR is supported on import only. You cannot render to this file
format.

■ Only RGB OpenEXR files can be imported and not RGBA.

■ You must convert the OpenEXR, 16-bit float data to the 16-bit integer
Lustre internal format. This is done using the built-in Float Conversion
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LUT option, found in the Calibration settings of the project configuration
settings.

ProRes

The QuickTime® ProRes 422 and ProRes 444 codecs are now supported, for
ingest.

NOTE The ProRes codecs are supported on Mac® OS only.

RED Media
The following improvements have been made to Lustre for RED media:

■ The RED camera firmware version is now visible when you are browsing
RED media using the file browser.

■ Audio is now supported. Make sure the Include Audio option is enabled
when you import the RED footage. Only the audio for a single associated
image file can be imported or loaded at a time per grade.

R3D SDK 3.0 Support
Wiretap Gateway leverages the version 3.0 of the R3D SDK, enabling the
following new transcoding options:

■ New ISO / FLUT / Shadow / Colour Space and Gamma Curve

■ A new option to choose the R3D SDK version used when importing
REDCODE RAW media (SDK 2.x or 3.x)
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Support for the RED ROCKET Board

The Wiretap Gateway can leverage a RED ROCKET™ board installed on a Mac
workstation. This can improve the speed of decoding and debayering R3D
files.

The RED ROCKET board can be installed on a 32-bit Mac OS X system running
the Wiretap Gateway server, connected to the Lustre workstations by a 10-GigE
network.

Wiretap Gateway systems equipped with a RED ROCKET board are identified
in the Lustre file browser.

NOTE If you have multiple creative applications on a Mac equipped with a RED
ROCKET board, only one application will be able to use the card at a time.

File Browser
The file browser user interface has been updated so the layout now resembles
the Shot bin. See Accessing the File Browser on page 25. Aside from the new
user interface, you can now accomplish the following within the file browser:

■ You can create and delete folders.

■ You can delete all the files within a folder.

■ You can hold down the Ctrl key and click the Delete button to delete
selected file folders. (You must confirm the deletions.)

■ The version number of the Wiretap server and Wiretap Gateway is now
visible within the file browser.

■ You can filter out folders by using the keyword in the init.config file. Once
the keywords have been determined, you can enable the Filter button in
the file browser to hide those folders.

■ When you are in Details or Proxies view, clicking on the name field of a
thumbnail now only selects the thumbnail and no longer picks it up.
Clicking on the thumbnail with the cursor picks up the shot.

■ When you are in List view, click in the Shot Place column to drag and drop
shots to the Shot bin or Storyboard. Clicking in any other column will
only select the shot.
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Shot Bin
A new feature of the Shot bin is that it is now possible to drag and drop files
from one Shot bin folder to another. This allows you to assemble an EDL with
media you have dragged and dropped into a specific folder.

Import File Browser
The option to copy EDL, audio and LUT files outside of Lustre is now
complemented by a browser within Lustre to browse to and import a copy of
an EDL, audio, or LUT file to the appropriate location. The files visible in the
browser are dependent on the type of file selected for import.

See Importing an EDL, ALE, or Cutlist File on page 31, Importing a LUT File
on page 33and Importing an Audio File on page 35.

Enhanced Grade Bin
The Grade bin feature is updated. See Using Grade Bins on page 39 and Using
the Expanded Grade Bin on page 48. The enhancements are as follows:

■ Storage containers with stereoscopic content contain grading data for the
Left Eye and Right Eye.

■ In a stereoscopic project, the Player in the Grade view displays the grade
for the assigned eye.

■ You can now drag grading data from one storage container and drop it
into another.

■ A new type of Grade bin stores marry grade files. Marry grade behaviour
has been updated in Lustre 2011. See Marry Grade Support on page 15.

■ The location of the New Folder button has moved from the expanded
Grade bin to the file browser.

■ You can now use the Delete Folder button in the file browser to delete
grade file folders.

■ You can select folders in the file browser and press Ctrl+Delete to delete
them.

■ You can select grade files in a folder and press Ctrl+Delete to delete selected
grade files.
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■ When you are in Details or Proxies view, clicking on the name field of a
thumbnail now only selects the thumbnail and no longer picks it up.
Clicking on the thumbnail with the cursor picks up the shot.

■ When you are in List view, click in the Name column to drag and drop
shots to the Grade bin or Storyboard. Clicking in any other column will
only select the shot.

■ You can right-click a grade file in the expanded Grade bin to load its
reference image into the frame buffer.

Data Management

EDL Assembly
The following are the enhancements made to the EDL assembly feature:

■ Since you can now drag and drop shots from one Shot bin folder to another,
you can assemble an EDL based on the shots within that folder.

■ Enhancements have also been made for EDL assembly with a stereoscopic
project. See EDL Assembly on page 12.

Wiretap Interoperability
The following is the list of the new and improved interoperability features
between Lustre and the Visual Effects and Finishing applications:

■ Previously, marry grade files could only be created with content coming
exclusively from the Wiretap server (soft import/publish only). Now, marry
grades can be created with content coming from both the Wiretap server
and the Wiretap Gateway.

■ Previously, media located on the Stone FS or Standard FS could not be used
with the dust removal option. You are now able to use media from the
Wiretap server, Wiretap Gateway, and Stone/Standard FS when performing
dust removal within Lustre.

NOTE The render options within the Image > Dust menu are inactive when
media is imported from the Wiretap server or Wiretap Gateway server. You
can only render by using the Dust option within the Render > Local menu.
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■ Stereoscopic timelines are now supported on import and render.

NOTE Stereoscopy is not supported when an Incinerator® cluster is connected
to Lustre.

■ 16-bit floating point timelines are now supported on import and render.
When rendering 16-bit floating point media to Wiretap, select the “Identity
Extended” output LUT in the Render > Output menu.

NOTE Once you render the 16-bit half float media, the display will become
lighter.

■ It is now possible to import a timeline compiled of R3D media,
soft-imported in Flame® or Smoke® 2011, and apply the Lustre transcode
options. This applies to media soft-imported from Standard FS filesystems
only. It does not apply to material on Stone FS filesystems.

NOTE Lustre has read/write access to media via any current Wiretap server. Earlier
Wiretap server versions may provide read-only access.

Viewing Options
The colour view mode previously allowed you to display all the colour channels
of an image, or individual channels in greyscale. The enhanced colour view
mode for Lustre 2011 provides you with a Viewing options panel that allows
you to select the colour view mode and viewing option. See Setting the Viewing
Options on page 59. From the Viewing Options, you can select one of the
following colour view options:

■ All colour channels

■ Only the red channel

■ Only the green channel

■ Only the blue channel

■ Luminance

Within the Viewing Options, you are now able to select the following:

■ Single View: This is the default view. You can select which playhead you
want to display in the viewer (i.e., Playhead A or B).
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■ Dual View: You can display the image of Playhead A and Playhead B at
the same time. You can view these images side-by-side in two viewers, or
as an image in a single viewer in a split view. A split view can be displayed
with a horizontal or vertical wipe. You can modify the proportion of each
image that displayed using the Value slider.
If you are working in a stereoscopic project, you can also use this mode to
display the image for Playhead A and B, or the Left and Right Eye of the
current frame at the same time. See Player Viewing Options on page 13.

■ Multi View: You can display 2, 4, 9, or 16 shots.

As you make your viewing selections, the image on the View Mode button
updates to reflect the options you have selected.

TIP To return to the default Single view, right-click the View Mode button or press
F5.

You can also modify viewing options using the hotkeys and the Autodesk
Control Surface. See Hotkeys on page 17 and Autodesk Control Surface (ACS)
on page 18.

Stereoscopic Workflow
The following enhancements improve the workflow for stereoscopic projects.

Stereoscopy State
When a project is set to stereoscopy mode by enabling the Stereoscopy button
in the Setup > Grade menu, the saved cut will now retain the setting when it
is reloaded in Lustre.

EDL Assembly
The following enhancements improve the process of EDL assembly in a
stereoscopic project:

■ When you enable the Match Grade feature for a stereoscopic timeline, the
shots in the Left Eye and the Right Eye will be matched, respectively, to
the cut file’s left and right shots.
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■ When you load a Colour Decision List (CDL) in the EDL Panel, CDL data
is applied to both the Left Eye and Right Eye.

■ A change cut can be applied from one stereoscopic timeline to another. If
other layers exist in a timeline that is not assigned to a Left Eye or Right
Eye, the layer remains unchanged.

For more information, see Assembling a Stereoscopic EDL on page 69.

Player Viewing Options
In Dual View mode, you have the option to view an image in the Left Eye and
Right Eye at the same time, instead of an image in each playhead. In addition
to the horizontal and vertical wipe, you can use the Blend option to display
the image of one eye overlaid over the other and edit the level of blending
between the Left Eye and Right Eye. See Viewing Stereoscopic Footage in Dual
View on page 71.

Storyboard Viewing Options
The collapse function and timeline sort modes are now fully supported in a
stereoscopic project.

Editing
For a Left Eye and Right Eye with identical timelines, when Sync mode is
enabled, the following editing operations are fully supported:

■ Adding or removing dissolves

■ Editing dissolve curves and duration

■ Selecting elements in the Storyboard or Timeline

■ Cutting or joining elements

■ Trimming, retrimming, slipping, and sliding elements

■ Deleting elements

■ Retiming shots

■ Performing confidence checks
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■ performing scene detection

Grading
The following grading operations are now fully supported in a stereoscopic
project (see Grading Stereoscopic Footage on page 73):

■ When Sync mode is enabled, load, copy, and drag-and-drop operations
for Left Eye and Right Eye grading data is applied to respective destination
eyes (for example, grading data dragged from a Right Eye layer is always
applied to a Right Eye destination layer, even if it is dropped on the Left
Eye). See Synchronizing the Left and Right Eye on page 72.

■ When Sync mode is enabled, you can copy Left Eye and Right Eye grading
data from one secondary layer to another, and the grading data for each
eye that was applied when Sync was disabled will be copied to appropriate
eyes.

■ When Sync mode is enabled, you can now use the Match feature to match
colours for both the Left Eye and Right Eye simultaneously.

■ When Sync mode is enabled, you can click the Bypass button to bypass
the menu parameters of both eyes simultaneously. When Sync mode is
disabled, the menu parameters of the selected eye are bypassed. See
Bypassing Menu Parameters of an Eye on page 74.

Repositioning Images
Use the Convergence feature to reposition Left Eye and Right Eye shots
simultaneously and fix discrepancies. When both Sync and Convergence
modes are enabled, the horizontal, vertical, and scale repositioning sliders
will offset the assigned eye and cause the unassigned eye to have an equal
and opposite offset. See Repositioning the Left Eye and Right Eye on page 70.

Dust Removal
You can now perform dust removal operations while working in a stereoscopic
project. Dust removal is only performed on one eye at a time.
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Reference Images
When viewing reference images, images for both the Left Eye and Right Eye
are displayed simultaneously in frame buffer.

Autodesk Control Surface Stereoscopy Options
You can also control some stereoscopic workflow features using the Autodesk
Control Surface. See Autodesk Control Surface (ACS) on page 18.

Marry Grade Support
The marry grade feature is updated with the following in Lustre 2011. See
Saving and Loading Marry Grades on page 55.

■ You can now generate marry grade files for stereoscopic footage.

■ You can now generate marry grade files for content imported from the
Wiretap Gateway and the Wiretap Gateway Server.

■ Marry grades have a dedicated shot-based Grade bin, in which more than
one version of the marry grade can be saved per shot. Marry grades used
in the current project can be accessed via the storage containers in the
standard Grade bin. Marry grade folders can be accessed and displayed in
the Grade view. See Using the Marry Grade Bin on page 40.

■ You can hold the Shift key and double-click a marry Grade bin storage
container to load the grade to the selected shot in the Storyboard and all
shots after it.

■ Marry grade files can be saved as binary or XML files. To save a marry grade
file as an XML file, hold down Ctrl as you click the Save button.

■ You can generate marry grade files based on the wedge number range or
its unique identifier (UID). In the Rendering menu, the options in the
Marry Grade Format option box are now Based on Wedge and Based on
UID to reflect this change. The directory structure of marry grade files
contains folders based on the format selection. Each folder is named after
the range of frames based on the format selection.
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Other Enhancements

InfiniBand Support for BrowseD Expanded
Lustre 2011 introduces InfiniBand support for the BrowseD server for all Lustre
Linux® workstations. Using BrowseD over InfiniBand allows you to achieve
faster rendering with Burn® for Lustre or the Slave Renderer.

To use BrowseD over InfiniBand, you need to obtain a special BrowseD IB
license. This license allows you to use BrowseD over InfiniBand or over GigE.

See the latest version of the Lustre Installation and Configuration Guide for
information on enabling InfinBand for BrowseD, and on configuring Burn
for Lustre and the Slave Renderer to use the BrowseD server.

Storyboard Update
There are changes as to how and when the Storyboard is updated:

■ In the Setup > Interface menu, the Storyboard Update button toggles how
thumbnails are updated in the Storyboard. This feature can also be enabled
by pressing Shift+1.

■ The Storyboard updates when grading is applied using the keyboard or the
Autodesk Control Surface.

■ The Storyboard updates in Bypass mode, and after a Reset, Undo, or Redo
operation.

■ When changes are made to shots within the timeline, Lustre only updates
the thumbnail of the shot within the Player. The remaining shots will have
a grey dot in the bottom-right corner signifying that there are updates to
the thumbnails. See Updating the Storyboard Thumbnails on page 37.

Video Playout
The following are enhancements made to the Playout menu:

■ If the Telecine feature is enabled in the Editing > Playout menu, and Video
Info is enabled within the Render > Local menu, the source timecode is
visible on the footage after you render the media.
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■ If the Telecine feature is enabled in the Editing > Playout menu when the
VTR emulator is created, the VTR emulator operates in telecine mode by
sending the source timecode on the RS-422 port.

Hotkeys
The following is a list of global viewing hotkeys.

To:Press:

Display Playhead A.F1

Display Playhead B.F2

Cycle through the colour view selections (i.e., colour, red,
green, blue, and luminance channels).

Ctrl+F1

Return to the previous colour view selection.Shift+Ctrl+F1

Cycle through the viewer options (i.e., Single, Dual, or Multi
view).

F3

Return to the previous viewer option.Shift+F3

Cycle through the Playhead A and B Dual view modes (i.e.,
2-up, horizontal wipe, and vertical wipe).

F4

Return to the previous Playhead A and B Dual view mode.Shift+F4

Cycle through the Stereo Dual view modes (i.e., 2-up, hori-
zontal wipe, vertical wipe, and blend).

Ctrl+F4

Return to the previous Stereo Dual view mode.Shift+Alt+F4

Toggle between the current view options and the Single
(default) view.

F5

Cycle through the Multi view modes (i.e., 2, 4, 9, and 16).Ctrl+F5

Return to the previous Multi view mode.Shift+Ctrl+F5

Swap the position of two shots.Shift+’

Enable Update Storyboard mode.Shift+1
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To:Press:

Show the high dynamic range (HDR) value of the selected
colour within the OpenEXR media.

E

Delete selected grade files in the expanded Grade bin.Ctrl+Delete

If no grade files are selected, delete selected folders in the
Grade view file browser.

Ctrl+Delete

Autodesk Control Surface (ACS)
The following is a list of additional functionality that has been added to the
ACS panel.

Stereoscopy Hotkeys
New options are accessible through the ACS to accommodate stereoscopic
workflows. See Working with Stereoscopic Projects on page 74.

To:Press:

Toggle the Sync mode state. The state of the Sync mode appears on the
digital display of the Colour Grading panel.

F3

Toggle between the Left Eye and the Right Eye. The currently assigned
eye appears on the digital display of the Colour Grading panel.

F4

Enable and disable Convergence mode. When Convergence mode is
active, it is displayed on the digital display of the Function panel. See
Repositioning Shots on page 75.

F5

Viewing Option Hotkeys
The new viewing options are also accessible through the ACS.

To access the viewing options:

1 On the Navigation panel, press the top More button and then Grade.

2 Using the F1-F4 buttons on the Navigation panel, adjust the viewing
option. See Player Viewing Options on page 65.
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Other Changes
The following is a list of the additional changes for Lustre:

■ The selection process in the Details, Proxies, and List views are consistent
in the File Browser, Shot bin, and expanded Grade bin.

■ You can now select the grades of multiple shots in the timeline and copy
them to another set of shots (in the same layer or in another layer). Shots
do not have to be next to each other.
For example, in a 5-shot sequence, the first, third, and fifth shot in a layer
are selected. While holding down the Shift and Ctrl keys, the grade selection
is dragged and dropped to a new set of destination shots: the grade selection
is copied to a destination shot on which it is dropped, and the third and
fifth shot after it. The second and fourth timeline segments in the
destination shots will be unaffected.

■ You can now swap the position of two shots selected in the Storyboard or
the timeline. The shots can be in different layers (or eyes, in a stereoscopic
project). Once the two shots are selected, press Shift+’ to interchange the
position of the selected shots in the timeline.

■ You can select shots within a sorted timeline and sort the new selection.
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Audio

Playback Using the LTC Chase Option
The LTC Chase Options allow you to send the timeline's timecode through the
DVS or AJA BOB to an audio device that can chase the LTC timecode. By default,
the LTC timecode is the same as the record time (REC TC). For example, if the
start timecode for the timeline is 10:00:00:00, the LTC will be 10:00:00:00.
When you move the shot positioner to a further position in the timeline and
press play, the LTC value is also updated so it is in sync with the record timecode.
If the Telecine option is enabled in the Editing>Playout menu, the LTC timecode
is the same as the source timecode.

NOTE Your LTC Chase Option settings are saved in the context.config file.

To play back the audio track using the LTC Chase Options:

1 Click Editing in the Main menu, and then click Capture.

2 Select the appropriate raster to observe the audio and video files together.
Refer to “Selecting a Raster for Playout” in the “Video Capture and Video
Playout” chapter of the Luster user guide.

3 (Optional) Click Setup in the Main menu, and then Audio to display the
Audio menu. If you are using the AJA BOB, select an audio channel from
the LTC Track Selector that is to represent the LTC channel.

2
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a

(a) LTC Track Selector option box

NOTE Since the AJA BOB does not have a designated LTC channel, you must
assign one of the audio channels to be the LTC channel. Refer to the Hardware
Guide for information on how to setup the AJA BOB for the LTC Chase Option.

4 Make sure the audio device is set to chase.

Now when you play back the timeline, the audio track is played at the
same time.

Use Explicit Timecode
If the audio device has a different timecode than the timeline, you can set a
different timecode by enabling the Use Explicit TC button. For example, if
your source timecode starts at 10:00:00:00 and your audio timecode begins
at 11:00:00:00, you can enable the Use Explicit TC option and create an offset
of 1:00:00:00.

To play back an audio track with a different timecode:

1 Click Editing in the Main menu, and then click Capture.

2 Select the appropriate raster. Refer to “Selecting a Raster for Playout” in
the “Video Capture and Video Playout” chapter of the Lustre User Guide.

3 Click Setup in the Main menu, and then Audio to display the Audio
menu.

4 (Optional) If you are using the AJA BOB, select an audio channel from
the LTC Track Selector that is to represent the LTC channel.
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a

(a) LTC Track Selector option box

NOTE Since the AJA BOB does not have a designated LTC channel, you must
assign one of the audio channels to be the LTC channel. Refer to the Hardware
Guide for information on how to setup the AJA BOB for the LTC Chase Option.

5 Enable Use Explicit TC.

6 In the timecode field, enter the timecode of when you want the audio
track to begin.

Now when you move the shot positioner, the audio and video are in
sync.
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File Browser

Accessing the File Browser
Use the file browser to locate shots and load them into the Shot bin.

To access the file browser:

 ➤ Click Editing, and then click Browse.

The Browse menu and the file browser appear.

a b

c

(a) Shot bin (b) File browser (c) Browse menu

3
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When you are in the Browse menu, the work area is divided into three areas.

Shot bin  Use to organize the shots you are using in your cuts.

To:Click:

Display shots in Thumbnail and Text view. Traditional methods of
multi-selecting (Shift-click, Ctrl-click) are disabled.

Details

Display shots in the Shot bin as thumbnails. Traditional methods
of multi-selecting (Shift-click, Ctrl-click) are enabled.

Proxies

Display shots in Text view.List

Select all shots in the Shot bin so that they can be added to the
Storyboard simultaneously.

Select All

Deselect the selected clips in the Shot bin.Unselect All

Display the contents of the selected folder.Expand

Hide the contents of the selected folder.Collapse

Create a new folder. First select the main folder under which the
new one is to be created. Rename the folder by right-clicking it and

New Folder
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To:Click:

entering a new name (the root, Shot bin, cannot be renamed).
Shots already in the Shot bin cannot be moved to the new folder.

Delete selected shots.Delete Selected

Delete all shots from the Shot bin. Another click of this button is
required for confirmation.

Delete All

File browser Use to locate footage and bring it into the Shot bin. When
copying captured footage into Lustre, always place the files into the Scans-Full
home directory. In the file browser, you can see if files are correctly located
in the Scans-Full home directory. If they are local files, the path to the media
file starts with the word <HOME>.
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To:Click:

Display details about all clips.Details

Display only the clip thumbnails (without details).Proxies

Display shot information in a tabular Text view.List

Select all clips in the file browser.Select All

Deactivate all selections in the file browser.Unselect All

Display the contents of the selected folder.Expand

Hide the contents of the selected folder.Collapse

Create a new folder in the currently selected folder.
Rename the new folder by right-clicking it and enter-

New Folder
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To:Click:

ing a new name (the root folder cannot be renamed).
Clips already in the file browser cannot be moved to
the new folder.

Delete selected shots. (To confirm deletion, Hold down
the Ctrl key and click again.)

Delete Selected

Delete all shots from the Shot bin. (To confirm dele-
tion, Hold down the Ctrl key and click again.)

Delete All

Downloads audio tracks from the Wiretap server.Include Audio

Display the timelines coming from the Wiretap server.Timelines Only

Hide specified folders (defined in the init.cfg file) from
the file browser view.

Filter

Rescan the file systems and update the file browser
with up-to-date information.

Refresh

Browse menu  Use to create and manage the cuts in the project.

Accessing the File Browser | 29



30



Import File Browser

Importing an EDL, ALE, or Cutlist File
Before you can assemble an EDL, ALE, or Cutlist file, you have to copy the file
into the current scene's sacc_data directory.

NOTE The file must have a *.edl, *.ale, or *.ctl file extension or it will not appear in
the EDL list.

There are two ways to import EDLs into Lustre:

■ Outside of Lustre, files can be copied manually to the sacc_data directory of
the current scene. If running the Windows version of Lustre, save the EDL
to the C:\Program Files\Autodesk\Lustre
2011\projects\<project_name>\sacc_data folder. If running the Linux version
of Lustre, save EDLs in the /usr/Autodesk/lustre_2011/projects/<project
name>/sacc_data directory.

NOTE Press Ctrl+R to refresh the EDL list to see recently copied files.

■ Within Lustre, copies of EDL files are imported using the Import file browser.

To import a copy of an EDL, ALE, or Cutlist file while in Lustre :

1 Click Editing, and then click Assemble.

The Assemble menu appears.

4
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a

b

(a) EDL list (b) Browse button

2 In the EDL List, click the Browse button.

The Import file browser appears.

3 Navigate to the appropriate source folder and select one or more EDL
files. Traditional methods of multi-selecting (Shift-click, Ctrl-click) are
enabled.

4 Click Import or press Enter.

WARNING If an EDL with the same filename is already in the EDL list, the
Import button will turn red. You must click again to confirm that you want
to overwrite the file.
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TIP If no files are selected, you can also press Enter to cancel file selection
and close the Import file browser.

A copy of the file is imported into the sacc_data folder, and appears in
the EDL list.

Importing a LUT File
Lustre can use the LUT files that you import into the application folder’s lut
directory. The LUT filename is displayed when the LUT list is displayed.

There are two ways to import LUTs into Lustre:

■ Outside of Lustre, files can be copied manually to the application lut folder.
If running the Windows version of Lustre, save print LUTs in the C:\Program
Files\Autodesk\Lustre 2011\lut folder. If running the Linux version of Lustre,
save print LUTs in the /usr/Autodesk/lustre_2011/lut directory.

■ Within Lustre, copies of LUT files are imported using the Import file
browser.

TIP Lustre provides industry-standard 3D LUTs which are located in C:\Program
Files\Autodesk\Lustre Color 2008 SP3\3D LUTs in the Windows version
and/usr/discreet/Lustre_Color in the Linux version.

NOTE 1D LUTS, 3D LUTs and floating conversion LUTs must have the naming
convention, <name.lut>, <name.3dl>, and <name.fclut>, respectively, or they will
not appear in the LUT list.

All LUT lists contain 1D and 3D LUTs, except the Float Conversion LUT list.
Files with the .fclut extension can be imported to the Float Conversion LUT
list are exclusive to that list.

To import a file while in Lustre:

1 Open the Input LUT menu.

2 In the LUT List, click the Browse button.
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The Import file browser appears.

3 Navigate to the appropriate source folder and select one or more LUT
files. Traditional methods of multi-selecting (Shift-click, Ctrl-click) are
enabled.

4 Click Import or press Enter.

WARNING If a LUT with the same filename is already in the LUT list, the
Import button will turn red. You must click again to confirm that you want
to overwrite the file.

TIP If no files are selected, you can also press Enter to cancel LUT file selection
and close the Import file browser.
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A copy of the LUT file is imported into the lut folder, and appears in the
LUT list.

Importing an Audio File
Lustre can use the audio files that you import into the scene's sacc_data\audio
directory or embedded in media imported from the Wiretap or Wiretap
Gateway server.

NOTE The audio folder is automatically created when you create a scene.

An imported audio file can comprise of a single track or up to 16 interleaved
tracks.

There are three ways to import audio into Lustre:

■ Outside of Lustre, copy WAV or AIFF files manually to the scene’s
sacc_data\audio folder.

■ Within Lustre, import copies of audio files using the Import file browser.

■ Within Lustre, import audio through the Wiretap server and Wiretap
Gateway server.

To import an audio WAV or AIFF file while in Lustre:

1 Click Setup in the Main menu, and then click Audio.

2 In the audio file list, click the Browse button.

The Import file browser appears.
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3 Navigate to the appropriate source folder and select one or more audio
files. Traditional methods of multi-selecting (Shift-click, Ctrl-click) are
enabled.

4 Click Import or press Enter.

A copy of the audio file is imported into the sacc_data\audio folder, and
appears in the audio file list.

NOTE If you add audio files to the scene’s sacc_data\audio folder after launching
Lustre, press Ctrl+R to refresh the audio file list.
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Storyboard

Updating the Storyboard Thumbnails
As you are making changes to the shots within your timeline, you may want
to automatically see the changes within the Storyboard thumbnail. The update
Storyboard option allows this to happen.

To enable or disable the automatic Storyboard thumbnail update option:

 ➤ Do one of the following:

■ Within the Setup > Interface menu, click the Update Storyboard button.

■ Press Shift+1.

■ Within the Display & Interface menu of the user configuration settings,
click Update Storyboard. Refer to “Display & Interface Settings” in the
“Project Management” chapter in the Lustre User Guide.

5
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If the Update Storyboard feature is enabled and you make changes to any shot
that is not currently in the Player, a grey dot will appear on the bottom-right
corner of the thumbnail. The grey dot signifies that a change has been made
to that shot, but the thumbnail has not been automatically updated.

When you apply changes to a group of shots, only the thumbnail of the current
shot within the Player is automatically updated. To update the other
thumbnails, click the Storyboard thumbnail with the grey dot.
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Enhanced Grade Bin

Using Grade Bins
Store shot settings to a Grade bin when you need grades for future reference or
scratch pad memories. Intermediary grades are useful when you want to
experiment with different looks. Grades are saved on a shot-by-shot basis and
contain all shot and animation settings.

The location of grade files determine how they can be shared between users
scenes, and projects.

Contains:Grade bin
type:

Grades saved for use between all users and projects on the
current workstation.

Global

Grades saved for the current project only.Project

Grades saved for the current scene only.Scene

Grades saved for the current user only.User

Grades saved in a user-defined folder. See Defining the Quick
Folder.

Quick

Grades saved as Marry grade files. See Using the Marry Grade
Bin on page 40.

Marry

TIP Place the cursor anywhere outside the file browser or expanded Grade bin, and
press Shift+- to cycle through the display of different types of Grade bins.

6
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You can also use Grade bin thumbnails as reference images.

Using the Marry Grade Bin
Unlike the other Grade bins, which are used to apply grading to any shot(s)
in a given timeline, a Marry Grade bin is shot-specific. Each shot in the cut
has its own dedicated Grade bin for its Marry grade files. For example, if a cut
is composed of three shots, three Marry Grade bins exist, although the only
visible Marry Grade bin is the one for the current shot. This allows you to save
multiple Marry grades to the same shot.

Marry Grade file information is also displayed in the Grade view. Marry grade
files are saved with their source media files (Marry grade files for media
imported from Wiretap and Wiretap Gateway are saved with local links to the
shots). Enable the Marry button under the file browser to navigate to the file
folder in which Marry grades are located. See Using the Expanded Grade Bin
on page 48.

You can also use the Marry grade controls in the Setup > Grade menu to save
Marry grade files into the Marry Grade bin. See Saving and Loading Marry
Grades on page 55.

Saving Grades
You can save grades to the Grade bin. When you save grades, all the settings
are saved with a high-resolution image and a thumbnail for identification. By
saving your shot settings to the appropriate Grade bin, you can save your shot
settings globally, to a predefined folder, or limit them to a user, scene, or
project. You can also save them with your shots as Marry grade files.

If you save grades to a global, project, scene or user Grade bin, each selected
grade is saved in a separate storage container, starting from the selected
container and proceeding column by column and left to right.

If you save grades to a Marry Grade bin, each selected grade is saved in a
separate storage container in the current container position (highlighted in
red) in the Grade bin for the shot.

To save a grade to a Grade bin:

1 Select the Grade bin you want to use (for example, the Grade bin for the
current project).
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2 (Optional) Scroll to the area of the Grade bin you want to use. To scroll
through a Grade bin, middle-click and drag right or left, or use the
horizontal slider located immediately below the Grade bin. The red line
in the slider indicates the current position.

3 Do one of the following:

■ To create a grade, select an unused storage container.

■ To save a new version of a grade, select the storage container of the
current grade.

a

b

(a) Used storage container (b) Unused storage container
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NOTE When you add a grade to a container in the last column of the Grade
bin, three new columns are automatically added to the right. You can add
an unlimited number of grades.

4 Click Save.

The settings from the current shot in the timeline are saved to the
intermediary grade and a thumbnail of the current frame appears in the
Grade bin.

TIP You can use the thumbnail as a reference image while you work on
another shot.

5 (Optional) Enter a name or comment in the Note field and press Enter.

To save grading information from several shots to the Grade bin:

1 Do one of the following:

■ To choose grades for specific shots, use the Storyboard or the
Multi-Layer Timeline to select the shots whose grading information
you wish to save to the Grade bin.

■ To choose all shots in the timeline, leave all shots unselected.

2 In the Grade bin, select the storage container where you wish to save
your grade.

3 Make sure the positioner is over a shot.
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4 Hold down the Shift key while pressing the Save button.

WARNING Storage containers with existing grading information will be
overwritten. If you are saving to storage containers that already have grading
information, Lustre prompts you to confirm you want to overwrite these
grades.

5 If you are saving to storage containers that already have grading
information, confirm or cancel the action when Lustre prompts you to
confirm the action.

The selected grades are saved to the Grade bin.

Applying Grades to Shots
You can apply grades to one or multiple shots in the Storyboard or timeline.
Apply intermediary grades to your shots when you want to experiment with
different looks. You can control which saved settings you want to apply—all
the settings from the intermediary grade, only those selected in the Selector,
or only those in the current menu.

To load intermediary grades from a Grade bin:

1 In the Storyboard, select the shots to which you want to apply an
intermediary grade.

TIP You can select multiple shots by right-clicking them in the Storyboard.
You can also create groups of shots.

2 Select the Grade bin you want to use.

NOTE If you select the Marry Grade bin, each shot that you select will be
loaded with the corresponding Marry grades for that specific shot. See Using
the Marry Grade Bin on page 40.
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3 (Optional) Scroll through the Grade bin to the thumbnail representing
the grade you want to load. To scroll through a Grade bin, middle-click
and drag right or left, or use the horizontal slider located immediately
below the Grade bin.

TIP To display an enlarged image of the thumbnail, place your mouse cursor
over a thumbnail without clicking.

4 Click a thumbnail to view its name.

The thumbnail is outlined in red and its name appears in the Note field,
which is editable by clicking the field.
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5 Do one of the following:

■ To load all the settings in the grade to the current shot only,
double-click a thumbnail.

TIP Double-click an unused storage container in the Grade bin to reset
selected shots to their default settings.

■ To load all the settings in the grade to selected shots, press Shift and
double-click a thumbnail.

■ To load the grade settings to the current shot only from the current
menu only, press Ctrl and double-click a thumbnail. For example, if
the Grading menu is displayed, the saved settings from the Grading
menu are applied.

■ To load the grade settings to selected shots from the current menu
only, press Ctrl+Shift and double-click a thumbnail. For example, if
the Grading menu is displayed, the saved settings from the Grading
menu are applied.

■ To load the grade settings that are selected in the Selector to the
current shot only, press Alt and double-click a thumbnail.

■ To load the grade settings that are chosen in the Selector to a selection
of shots, press Alt+Shift and double-click a thumbnail.

The grade is applied. In the Player, the image is updated to reflect the
current settings.
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TIP To revert to the previous settings, click Undo.

Within the Storyboard view, you can drag and drop the grading from one
shot to another. You can reapply the grading in one or more different shots
without having to drop it in the Grade bin first.

To drag and drop the grade from one shot to another:

 ➤ Do one of the following:

■ Hold down Ctrl+Shift and drag and drop to copy grades to multiple
destinations.

■ Hold down Ctrl+Alt and drag and drop to use the Selector to copy
grades to a single destination.

■ Hold down Ctrl+Shift+Alt and drag and drop to use the Selector to
copy grades to multiple destinations.

Deleting Grades
You can delete grades one at a time, or delete all grades from the Grade bin
simultaneously. When you delete a grade, the thumbnail is also deleted.

To delete grades from a Grade bin one at a time:

1 Select the Grade bin from which you want to delete grades.
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2 (Optional) Scroll through the Grade bin to the thumbnail you want to
delete. To scroll through a Grade bin, middle-click and drag right or left.

3 Click the thumbnail you want to delete.

The name of the selected thumbnail appears in the Note field.

4 Click Delete and confirm the action.

The grade and associated thumbnail are deleted.

To delete all grades from the Grade bin simultaneously:

1 Select the Grade bin from which you want to delete grades.

2 Hold down Shift while clicking Delete.

The Delete All button appears as a red confirmation button.

3 Do one of the following:

■ Click Delete All to clear the Grade bin.

■ Click outside the button to cancel the operation.
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Using the Expanded Grade Bin
Use the expanded Grade bin to locate and display grade files. You can manage
intermediary grade files at the global, project, scene, or user level, and Marry
grade files at the shot-based level. You can also define a custom folder and
bookmark it for quick access.

In addition to move, copy, and delete operations, you can create new folders,
enable a player to view grades and shots, and work in different views to view
grade files.

Accessing the File Browser
Use the file browser to locate grade data and load it into the Grade bin.

To access the file browser:

 ➤ In the Grade bin, click the Expand button.
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The Grade view appears.

ba c

(a) File browser (b) Expanded Grade bin (c) Player

When you are in the Grade view, the work area is divided into multiple areas.

File browser  Use to locate grade data and display it in the expanded Grade
bin. In the file browser, you can see if there are Grade bin folders at the user,
scene, project, or global level or in your Scans Full or Scans Half location.
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To:Click:

Display the location of the global Grade bin folder and
its contents.

Global

Display the location of the project Grade bin folder
and its contents.

Project

Display the location of the scene Grade bin folder and
its contents.

Scene

Display the location of the user Grade bin folder and
its contents.

User

Display the location of a pre-defined Grade bin folder
and its contents.

Quick

50 | Chapter 6   Enhanced Grade Bin



To:Click:

Display the location of a Marry Grade bin folder and
its contents. See Using the Marry Grade Bin on page
40.

Marry

Create a new folder under the currently selected folder.
Enter a new name. Rename the folder at any time by

New Folder

right-clicking it and entering a new name (the global,
scene, project, and user directories, cannot be re-
named).

Delete the currently selected folder (for which you
have deletion permissions enabled). To confirm dele-
tion, hold down the Ctrl key and click again.

Delete Folder

TIP Place the cursor over the file browser or expanded Grade bin, and press Shift+-
to cycle through the display of different expanded Grade bins.

Expanded Grade bin  Use to display and organize the grade files.
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To:Click:

Display grade files in Thumbnail and Text view. Traditional methods
of multi-selecting (Shift-click, Ctrl-click) are enabled.

Details

Display grade files in Thumbnail view. Traditional methods of multi-
selecting (Shift-click, Ctrl-click) are enabled.

Proxies

Display grade files in Text view.List

Display the contents of the expanded Grade bin and the Player.
Disable button to display the expanded Grade bin only. Press Q to

Player

alternate the display between a large Storyboard view and the
Player.

Select all grade files in the expanded Grade bin.Select All
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To:Click:

Deselect the selected grade files in the expanded Grade bin.Unselect All

Rescan the file systems and update the file browser and expanded
Grade bin with up-to-date information.

Refresh

Delete selected grade files.Delete Selected

Delete all grade files from the expanded Grade bin. (To confirm
deletion, hold down the Ctrl key and click again.)

Delete All

Show/hide a player in the Grade view.Player

Player  Use to display selected shots and grade files.

To:Click:

Display the current grade selected in the expanded Grade bin.Grade

Display the current shot selected in the Timeline or Storyboard.Timeline
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Deleting Grades From the Expanded Grade Bin
You can delete all or selected grade files from the expanded Grade bin.

NOTE Deleting grade files from the expanded Grade bin does not delete grade
data from the Storyboard.

To delete selected grade files from the expanded Grade bin:

1 Select the grade files you want to delete by doing one of the following:

■ Click Select All in the expanded Grade bin.
All the grade files are selected.

■ Press Ctrl and click the name on the thumbnail of the grade file.
Only the grade files you choose are selected.

2 Click Delete Selected, and then confirm the action.

All the selected grade files are deleted.

To delete all grade files from the expanded Grade bin:

1 Click Delete All.

2 Hold down the Ctrl key and click the Delete All button again to confirm
the action.

All the grade files are deleted.
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Marry Grades

Saving and Loading Marry Grades
When you save a grade using the Marry controls, the colour grading metadata
is saved separately from the regular grade file. Marry grade files are saved with
the original shots (except for shots imported from Wiretap or the Wiretap
Gateway). Marry grade files are also saved and loaded with the Marry Grade bin
and Grade view. See Using the Marry Grade Bin on page 40.

a

(a) Marry controls

You can save an individual grade for the current shot or grades for all the shots
in the timeline. Similarly, you can load the grade back to the current shot or to
all shots in the timeline. One situation where Marry grade files can be useful is
if you start your project working on a rough cut of a scene, and later are given
the final EDL for the scene. You can save the grades created for particular shots
on the rough cut and apply them to shots on the final cut.

Marry grade files can be created with content coming from the Wiretap server.
Marry grade files imported from a Wiretap location are stored in the wt folder

7
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of your project's Scans Half Home or Scans Full Home location. A local wt
folder is created for Marry grade files using media from Wiretap or Wiretap
Gateway.

Marry grade files are saved as binary files by default. You can also save the
grading metadata as an XML file.

NOTE You can load Marry grade files from previous versions of Lustre that are in
text format. They will be automatically converted into binary files.

The folders in which Marry grade files are saved are named based on the unique
identifier (UID) or wedge number of the shot. When you use the Scene Detect
function to splice a larger shot into individual shots, each scene-detected shot
is also assigned a unique identifier (UID). A shot is also assigned a wedge
number, which is a range based on the first and last frame in the shot. A wedge
number is also associated to shots that are spliced manually.

NOTE You can find the UID for each shot in the cut file located in your scene's
sacc_data folder.

When configuring the Marry Grade panel, select Based on Wedge or Based on
UID in the Marry Grade File Location option box. See Rendering Settings.

To save the grade of one or all shots in a cut:

1 Click Setup, then click Grade to display the Grade menu.

2 If you are saving the grade for one shot, navigate to that shot.

3 Using the Marry controls, do one of the following:

■ Click Save to save the grade for the current shot as a binary file.

■ Click Save All to save individual grades for each shot in the cut.

■ Hold down the Ctrl key and click either Save or Save All to save the
grade(s) in XML format.

To load the grade of one or all shots in a cut:

NOTE To load grades using the Marry controls, the shots in the two cuts must
point to the same original footage. If you want to apply the grade of one shot to
a different shot, use the Grade bin. See Using Grade Bins on page 39.

1 Load any cut containing one or more shots for which individual grades
have been saved.
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2 If you are loading the grade of one shot, navigate to the shot.

3 Using the Marry controls, do one of the following:

■ Click Load to load the grade of the current shot.

■ Click Load All to load the grades for all shots in the cut.

The grades are loaded to the shots. If the cut contains shots for which
no individual grades were saved, those shots are unchanged.
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Viewing Options

Setting the Viewing Options
Lustre has several ways to view and work with single or multiple shots in the
Player or the SDI monitor.

Within the Viewing Options, you can select the following:

■ Colour View  You can display all of the colour channels of an image, or
individual channels in greyscale. The greyscale versions of colour channels
represent, in values of grey, the amount of that colour channel found in
each part of the image. The darker the grey, the greater the amount of colour
present.

■ Single View  This is the default viewer. You can select which playhead you
want to display in the Player (i.e., Playhead A or B).

■ Dual View  You can display the image of Playhead A and Playhead B at the
same time. See Using Dual View on page 61.
If you are working in a stereoscopic project, you can also use this mode to
display the image for the Left and Right Eye of the current frame at the same
time. See Viewing Stereoscopic Footage in Dual View on page 71 .

■ Multi View  You can display 2, 4, 9, or 16 shots. See Using Multi View on
page 63.

To enable the viewing options:

1 Enable the Viewing Options button. The look of this button depends on
the viewing option that is currently selected.
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The Viewing Options panel appears to the left of the Grade bin.

2 Select the colour view option.

Cycle through the following options:

■ Colours

■ Red Channel

■ Green Channel

■ Blue Channel

■ Luminance

3 Select the number of shots to view using the Viewer option box.

To display:Select:

The default viewer. The viewer displays the image of the current play-
head.

Single View

The images of Playhead A and Playhead B. See Using Dual View on
page 61. For a stereoscopic project, it displays either Playhead A and

Dual View

Playhead B, or the Left Eye and the Right Eye. See Viewing Stereoscopic
Footage in Dual View on page 71.

2, 4, 9, or 16 shots. See Using Multi View on page 63.Multi View
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The Viewing Options are also accessible through the Autodesk Control Surface
panel. Refer to “Player Viewing Options” in “The Autodesk Control Surface”
chapter of the Lustre Control Surface User Guide.

To return to the Single view:

 ➤ Do one of the following:

■ Press F5.

■ Right-click the Viewing Options button.

This returns you to the default Single view.

NOTE Disabling the Viewing Options button does not disable the viewing
options you have selected.

Using Dual View
The two images displayed in Dual view are the current frames on Playheads
A and B. Dual view is useful for matching two shots or for copying colour
correction parameters from one shot to another. You can view images side by
side, or use a wipe. With a wipe (i.e., horizontal or vertical), you see a portion
of each image. You can control the position of the wipe bar by adjusting the
Value slider.

In a stereoscopic project, you can view the image of the Left Eye in one viewer
and the image at the same frame of the Right Eye in the other. Refer to
“Viewing Stereoscopic Footage in Dual View” in the “Stereoscopy” chapter of
the Lustre User Guide.

To display Dual view:

1 Do one of the following:

■ Enable the Viewing Options button, and in the Viewer option box,
select Dual View.

■ With the Viewing Options button enabled, press F3 or click the Viewer
option box to cycle through the viewer options until Dual View is
displayed.

■ If you are in Single view, and the previous mode was Dual view, press
F5 to toggle between the two views.
The last used mode in Dual view is displayed.
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2 Press F4 to cycle through the display modes.

■ 2-up  The current frames on Playheads A and B are displayed side
by side.

■ Horizontal Wipe  The images assigned to Playheads A and B appear
on the top and bottom, respectively.

■ Vertical Wipe The images assigned to Playheads A and B appear on
the left and right, respectively.
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TIP When applying a wipe, use the Value slider to edit the percentage of the
viewer that displays the image on Playhead B.

NOTE If you are working in a stereoscopic project, you can blend the Right
Eye image over the Left Eye. See Viewing Stereoscopic Footage in Dual View
on page 71.

Using Multi View
Multi view is useful for viewing your sequence in a Storyboard format while
developing continuity between shots. With Multi view, you see the entire
image, and you can cycle through viewing 2, 4, 9, or 16 shots.

To view multiple shots simultaneously in the Player:

1 (Optional) Select up to 16 shots.

NOTE If you do not select any shots, you will see the first shots in the
sequence in Multi view.

2 Do one of the following:

■ Enable the Viewing Options button, and in the Viewer option box,
select Multi View.

■ With the Viewing Options button enabled, press F3 or click the Viewer
option box to cycle through the viewer options until Multi View is
displayed.

■ If you are in Single view, and the previous mode was Multi view, press
F5 to toggle between the two views.
The last used Multi view mode is displayed.

3 Press Ctrl+F5 to cycle through the display modes.
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The first two shots displayed are the current frames on Playheads A and
B. The rest of the shots displayed are the selected shots, displayed
sequentially from left to right in the order of selection.

NOTE If no shots are selected, after the first two shots, shots starting at the
third shot in the cut are displayed sequentially from left to right.

4 (Optional) Pan the displayed shots by holding and dragging the middle
mouse button within the Player, or scale the displayed shots by holding
and dragging the middle and right mouse buttons within the Player.

You can make a new selection of shots while you are in Multi view. After you
have selected the new shots, press F6 to update the Multi view display with
the new shots.

Viewing Multiple Shots on the SDI Monitor
You can use Dual view and Multi view in the SDI monitor.

To view multiple shots on the SDI monitor:

1 Click Editing in the Main menu, and then click Playout.
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The Playout menu is displayed.

2 Make sure GFX/SDI is selected in the Video/Graphics Raster option box.

3 From the Raster list, select the video resolution and scan mode that
corresponds with your footage.

4 Press F7 to activate the SDI output mode.

5 Complete one of the following:

■ To view two frames on the SDI monitor, perform the procedure for
viewing two frames. See Using Dual View on page 61.

■ To view multiple shots on the SDI monitor, perform the procedure
for viewing multiple shots. See Using Multi View on page 63.

NOTE You cannot view horizontal wipes, vertical wipes, or blends on the SDI
monitor.

Player Viewing Options
There are several ways you can view the shots within the Player. You can
choose to display the shot(s) in a Single, Dual, or Multi view. These viewing
options are accessible through the Navigation panel.

To access the viewing options:

1 Press the top MORE button on the Navigation panel.

2 Press GRADE to access the viewing options.

3 Use the following controls.
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Adjust position or opacity value

#1.001.00001

Single
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F4F3BYPASS
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+/- RECALL GRADE

ALT ENTER

CURSOR

REVERT COMP

UNDO REDO DO

RESET OFFSET

SCROLLCLIP A/B

MARK 4 65

1 32

C

Colour
Storyboard Label Thumbs GuiPanelView

Viewing options

To:Press:

Cycle through the different colour view selections (i.e., colour, red, green,
blue, and luminance channels).

F1

Cycle through the different viewers (i.e., Single, Dual, or Multi view).F2

Toggle between Playheads A and B (A/B) or Left Eye and Right Eye (L/R).
This is only applicable for Dual view.

F3

Cycle through the Dual view modes (i.e., 2-up, horizontal wipe, vertical
wipe, or blend). Blend is only available if you have L/R selected. Cycle
through the Multi view modes (i.e., 2-up, 4-up, 9-up, or 16-up).

F4

NOTE To revert to the previous selection, press ALT on the Navigation panel
and the corresponding F1, F2, F3, or F4 button.
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4 (Optional) If you have selected a wipe or blend, you can adjust the
position of the wipe or the opacity of the blend by holding ENTER on
the Navigation panel and rotating the ring portion of the trackball.
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Stereoscopy

Assembling a Stereoscopic EDL
Use an EDL to rebuild a timeline using the original footage that matches the
edited timeline from the offline editing stage of post-production.

To assemble a Stereoscopic EDL:

NOTE This procedure is for every type of media except RED media.

1 Import the Left and Right Eye media that you want to assemble into its
corresponding Left or Right folder within the Shot bin.

2 Click Editing in the Main menu, and then click Assemble.

The Assemble menu is displayed.

3 Select the EDL you want to load from the EDL list and then click Load EDL.

4 Click Match Media.

5 Click Assemble to conform the EDL.

A stereoscopic EDL is created.

To assemble a stereoscopic EDL for RED Stereo workflow:

1 Import the Left and Right Eye media that you want to assemble into its
corresponding Left or Right folder within the Shot bin.

2 Click Setup in the Main menu, and then click Grade.

Make sure the Stereoscopy button is disabled.

3 Click Editing in the Main menu, and then click Assemble.
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4 Select the Right Eye EDL from the EDL list and click Load EDL.

5 Within the Shot bin, select the Right Eye folder.

6 Enable the Use Selected Folder button.

7 Click Match Media and then click Assemble to conform the EDL.

8 Enable the To Layer button.

9 Repeat steps #4-7 for the Left Eye media.

10 Click Setup in the Main menu, and then click Grade.

11 Enable the Stereoscopy button and then save the cut.

Repositioning the Left Eye and Right Eye
Repositioning is fully supported in a stereoscopic project. When Sync mode
is enabled, you can reposition both eyes at the same time. (For example, the
image in both eyes are offset horizontally by the same amount.)

You can also correct convergence discrepancies for the Left Eye and Right Eye
by repositioning images at the same time in an equal and opposite manner.
(For example, if you scale the image in the Left Eye to 0.80, the image in the
Right Eye will be scaled to -1.20.)

You can converge two images using the repositioning options of the Autodesk
Control Surface. See the Autodesk Control Surface User Guide.

TIP When converging a shot, select the Blend option in Dual View to overlay the
images in the Player. See Viewing Stereoscopic Footage in Dual View on page 71.

To converge Left Eye and Right Eye images:

1 Enable Sync mode. See Synchronizing the Left and Right Eye on page 72.

2 In the timeline, place the positioner over the two shots that you want to
converge.

3 Display the Reposition menu.

4 Enable Convergence.
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d

NOTE In the Preview window of the Reposition menu, the image reference
(i.e., the blue rectangle) is for the assigned eye only.

5 Enable a reframing tool.

6 Use the Reposition sliders to converge the shots. The other eye will be
offset in the equal and opposite manner.

Viewing Stereoscopic Footage in Dual
View
Once a stereoscopic project is enabled, you can display each eye at the current
frame at the same time in Dual View mode. As in A/B mode, you can view the
images side by side (2-up mode), or a portion of each image in the same viewer
(Vertical Wipe and Horizontal Wipe modes).

In a stereoscopic project, you can also view the Left Eye overlaid on the Right
Eye, as a blended image.

To display the Dual View Blend mode:

1 Display the dual viewer. See Using Dual View on page 61.

2 In the Dual View Display option box, select Left/Right.
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3 Do one of the following:

■ Select Blend.

■ Press Ctrl+F4 to cycle through display options until Blend is displayed.
The viewer displays the image of the Right Eye overlaid over the Left
Eye.

d

a b c

e

4 Set the Value slider to determine the percentage of opacity of the image
in the Left Eye.

Synchronizing the Left and Right Eye
Since the Player only displays either the Left Eye or Right Eye layer, it is difficult
and tedious to edit and grade one layer and create the same changes for the
other layer. An easy way for you to make sure any editing or grading is
automatically applied from one eye to the other is by using the Sync option.
When this feature is enabled, any editing or grading you do on one layer is
applied to the other.

To apply the editing and grading from one layer to the other:

 ➤ Fromthe Player display controls, click Sync.
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Now all editing and grading operations on one layer will be duplicated
on the other.

The Sync option only works if you do not break the sync. For example, if you
enable Sync and draw a geometry, whatever you do to that geometry on one
eye will be duplicated on the other. The moment you disable the Sync option
and change the geometry on one layer (e.g., colour, position, vertex, etc.),
that geometry will never be synced again when you re-enable Sync.

NOTE If you only break sync with the colour grading, the rest of the geometry
(i.e., position, vertex, etc.) will still be in sync once you re-enable the Sync option.

When you re-enable Sync mode, the grading data that was applied separately
on each eye will be retained on each eye. Re-enabling Sync mode will not
copy the grading back to the other eye.

Grading Stereoscopic Footage
When Sync mode is enabled, grading operations (including dragging and
dropping) are applied to the respective destination eye. For example, grading
data dragged from a Right Eye layer is always applied to a Right Eye destination
layer, even if it is dropped on the Left Eye. See Synchronizing the Left and
Right Eye on page 72.

Shots can still be graded separately when Sync mode is disabled. After grading
one eye, grading data can be copied to the other eye. Separate grading can
also be used to differentiate the grades on each eye.

During secondary colour grading, you can copy different grading data for each
eye at the same time from one secondary layer to another, and the grading
data for each eye that was applied when Sync mode was disabled will be copied
to appropriate eyes.

Working with Grade Files
In a stereoscopic project, grade files contain data for both the Left Eye and
Right Eye.
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In the Grade bin, each storage container can include Left Eye and Right Eye
grading data. The thumbnail of the grade corresponds to the currently assigned
eye. In the Grade view, the expanded Grade bin and its player demonstrate
the same behaviour. See Using Grade Bins on page 39 and Using the Expanded
Grade Bin on page 48.

Disable Sync mode to apply data from a grade file to only the assigned eye:
only the grade data for the current eye will be applied. When Sync mode is
on, data from a grade file is applied to both eyes: if the grades are different
for each eye, each grade is applied to the appropriate eye. See Synchronizing
the Left and Right Eye on page 72.

Bypassing Menu Parameters of an Eye
You can use the Bypass button to view the original shot of one eye or both
eyes.

Bypass results depend on the state of the Sync mode. See Synchronizing the
Left and Right Eye on page 72.

To:Set:

Display the original state of shots on the Left and Right Eye.Sync mode on

Display the original state of shots on the assigned eye.Sync mode off

Working with Stereoscopic Projects
The Autodesk Control Surface panel accommodates common stereoscopic
workflow operations. You must be in the Colour Grading or P&S menu to use
these controls.

Using the Navigation panel, you can change the Sync mode state. You can
also switch between the Left Eye and Right Eye.

When you are in Sync mode, you can use the Function panel to toggle the
Convergence tool. See Repositioning Shots on page 75.

To adjust stereoscopic features in the Navigation panel:

1 In the Navigation panel, enable the Grade or P&S menu.
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2 You can use the following controls.

To:Press:

Toggle Sync mode.F3

Toggle the assigned eye.F4

The Sync mode state and the assigned eye are displayed in the digital
displays of the Navigation panel and Colour Grading panel. When Sync
mode is enabled, the “L+R” appears in the digital display to indicate that
grading affects both eyes.

Repositioning Shots
You can reposition a shot by:

■ Scaling

■ Panning vertically and horizontally

■ Rotating

■ Changing the aspect ratio

■ Flipping and flopping

When Sync mode is enabled in a stereoscopic project, you can use the
Convergence tool to pan and scale both eyes at the same time in opposite
directions.

To reposition a shot:

1 Press the P&S button on the Navigation panel.
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2 On the Function panel, use the following controls.
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Pan X Pan Y Scale
Flip Flop
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Reset X Pan X Reset Y Pan Y Geom UI scale Reset scale Rotate
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Reset rotate

Flip
Flop

MULTI
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WIPE

O/P

SPLIT

STILL

PROXY

ALT

* * * *

Convergence

Convergence

To:Use:

Reposition the image.
Wheel 1=Pan X

Wheels

Wheel 2=Pan Y
Wheel 3=Scale
Wheel 4=Rotate
To reset a wheel, press the button above it.

Change the image's aspect ratio. To reset, press the
button below it.

Knob at right

Flip or flop the image.
F1=Flip

First row of buttons at bot-
tom right

F3=Flop
Toggle the state of the Convergence Tool.
F5=Toggle Convergence

Toggle the geometry wireframe on or off.SHOW button
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